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Swix and the X.500 directory.

The purpose of the X.500 directory is to facilitate communication. It is a global database of 
information about objects such as persons and organisations. You can compare the directory 
to a world wide telephone directory. Typical information you can expect to find is telephone 
numbers and electronic mail addresses.

Swix is a program which allows you to find information in the directory and keep it in your 
own address book. You can also use Swix to update the X.500 directory.

Swix is developed at UMDAC (umdac,Umea Universitet,se) and is based on the LDAP 
implementation from University of Michigan at Ann Arbor.

Swix overview.

In Swix you can retrieve information from the X.500 directory in two ways. You can Find an 
entry by giving a User Friendly Name (UFN) in the UFN text box at the top of the main 
window. An example of a UFN is "lindahl, umdac, umu, sweden". The other way is to enter a 
name in the text box and then use the Browse function to list all entries below the one that 
you specify.

In the text box you will see a name like "Umea Universitet, SE" or the name of your 
organisation if someone else has installed Swix for you. You can change this initial name to 
suite your needs by using the configure/search menu. To find a person within the organisation 
"Umea Universitet" you just enter a name in front like "Goran Lindahl, Umea Universitet, 
SE". To browse within the organisation click on the Browse button. 

Now, if you don't know how the directory is structured and the naming of the objects there is 
a short chapter which you can study. This and a few search examples should be enough to get 
you going. By the way, you can clear the text box to browse from the top level of the 
hierarchical catalog.

If the name you enter is not enough to find the entry in one go, Swix will try to find it by 
searching at the different levels of the directory. Swix will show you what is going on in the 
Message View at the bottom of the screen. In this window you can follow the progress of the 
search if you are interested.

If the search is successful you will see the result in two other windows, the List View and the 
Entry View. In the list view you will have a list of all the entries retrieved and you can scroll 
the list and select an entry by clicking on it. The selected entry is displayed in the Entry View. 
You can even specify the order in which the entries will appear. For example you might want 
to have the entries sorted on surname (last name). In the List View each entry is one row of 
information, by default the Distinguished Name of the entry is displayed. In the Entry View 
the attribute values of the current entry are displayed on separate lines.

Save the document and you have your own private address book. The next time you need the 
information you don't have to search in the global directory. Well, if the information is getting
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old you may want to retrieve it again, of course.

You can also write a tab separated textfile with,  for example, telephone numbers and E-mail 
addresses. Import the  textfile to your word processor and print an address list.

You can update the x.500 directory assuming of course you have permission to do that. The 
Entry View will then be replaced by the Edit View.
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Installation.

You have to have:

- At least a 386 machine running Windows 3.1
- TCP/IP communication with a winsock.dll

The most recent copy of Swix can be found by FTP from ftp.umu.se in the directory 
pub/pc/swix. It is a self extracting file which will give you the necessary files to run Swix and
this documentation in Write format.

Installation.

Create a directory, for example c:\swix.
Copy the installation file, for example swix21.exe, to this directory,  
and then run swix21.exe in this directory.

You will now have the program swix.exe. Open the program group where you want to create 
the new icon and create a new program object with information resembling this: 
Description:      Swix
Command Line: c:\swix\swix.exe
Working Directory: c:\swix

You may want to change the default server and default initial UFN. Use the configure menu in
Swix or, if you are installing for other users, you may want to edit the file default.cfg.

Files in the installation directory:

swix.exe X.500 directory user agent.
libldap.dll ldap library (c) Regents of the University of Michigan.
swix.hlp Swix help file.
attrib.cfg Attribute table.
layout.cfg Default attributes in the Entry View.
defaul.cfg Default startup values.
edattr.cfg Default attributes in the Edit View.
swixobj.cfg Definition of objects.
temp.cfg Templates defining the layout in the Edit View.
readme.txt File list and version news.
swix.wri This documentation in Write format.
seuppdat.wri Write document in Swedish: Uppdatering av X.500 katalogen från Swix.

ATTRIB.CFG

This file contains attribute names, attribute types and attribute labels. The labels will be used 
in the Entry View. You can edit this file, for example change the labels or add new attributes, 
but you should not attempt this unless you know what you are doing.
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LAYOUT.CFG

This file contains the default Entry View attributes and will be used each time a new 
document is created.

DEFAULT.CFG

Contains default values like the name of the server. A manger installing Swix can edit this file 
for local needs.

Modifying the X.500 catalog.

The following configuration files holds information necessary for updating the X.500 catalog.
Usually a manager will edit these files to suit local needs.

EDATTR.CFG

If no template can be used (defined in templ.cfg) then this file will decide the attributes that 
will be editable in the Edit View. If this file is deleted or renamed then templates must be used
to create an Edit View.

SWIXOBJ.CFG

This file will be used when modifying or creating a new entry. Specifically when creating a 
new entry the object that is to be created is defined here. These objects are also used when 
you create a template (in templ.cfg).

TEMPL.CFG

A template defines the Edit View layout used when modifying or creating a new entry. The 
name of the template should be the same as an object defined in swixobj.cfg. In the template 
you can specify if an attribute value must be filled in and also a default value.
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The X.500 directory, some technical issues.

This information is not really necessary to run Swix. However you will see some technical 
terms in error messages and if you do not already know their meanings this chapter tries to 
supply you with that knowledge.

The program that retrieves information from the directory is called a directory user agent 
(DUA). Swix is a DUA for Windows. The communication can be described as follows where  
"A --> B" means that A is requesting information from B.

user  <-->  DUA (directory user agent)  -->  the directory

Because of its size the directory is distributed over a large collection of computer systems. 
This means that the directory is a collection of directory system agents (DSAs) which 
cooperate to provide the information:

user  <-->  DUA  -->  DSA  -->  other DSAs (if necessary)

Some other terms which are used to describe this communication are client and server. The 
DUA is a client which requests information from the server (DSA). When you request 
information from the directory you must be connected to a server. 

However, there is something more involved called an LDAP server. This server is there to 
facilitate the development of client programs. The server you will contact when you run Swix 
is therefore an LDAP server, you enter the name of this server  under the "Configure/Server" 
menu. If you are running Swix it will look like this:

You  <-->  Swix  -->  LDAP server  -->  DSA --> other DSAs

You can see the names LDAP server and DSA in error messages: For example the error 
message "Can't contact LDAP server" means that the first communication step from Swix 
failed and you can't access the X.500 directory (unless you can find another available LDAP 
server).

When you get the error message "DSA is unavailable" the error is in either of the last two 
steps. If the LDAP server can't contact the DSA you will get the error at once when you try to 
search.In that case you can't reach the X.500 directory.

Finally if you get "DSA is unavailable" when a search has started it means that the server or 
DSA that you are connected to tried to contact another DSA but that server did not respond. In
that case you can't reach that part of the directory which is held by the DSA that is 
unavailable.
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How the information is structured.

The directory is made up of entries, each of which is composed of information about one 
object. An entry is made up of attributes, each concerned with some aspect of the object.

Example: An entry describing a person may contain these following attributes:

commonName Goran Lindahl
telephoneNumber +46 90-166070
mail Goran.Lindahl@umdac.umu.se
postalAddress UMDAC

901 81 Umea

The name of the entry is made up of one or more attributes. In the case of the entry being a 
person this is typically the attribute commonName. But that's not enough ...

In a world wide distributed system such as this the naming of entries is not so simple. The 
name has to be unique and also the DSAs have to know where to search. The directory is 
therefore structured as a tree. The complete name of the object is made up of the names of the 
entries above it in the tree. This unique name is called the Distinguished Name.

The hierarchy is most often set up in the following way. On the top level we have a country, 
below that an organisation and under that possibly one or more organisational units. These are
also entries in the directory. The attribute names used to name them, with their abbreviations 
in brackets, are country (c),  organization (o) and organizationalUnit (ou) respectively. 
CommonName is abbreviated to cn.

At the bottom of the tree we have entries which are called leaves. One example is the person 
above. He is working at the Computer Centre called umdac at Umea University in Sweden.  
The distinguished name is:

cn=Goran Lindahl, ou= umdac, o= Umea Universitet, c=SE

Note that the names are written in the form attributeName= value and that the order is bottom 
up.When searching for a specific entry Swix uses the above notation. However you don't have
to be that specific. There is something called User Friendly Name (UFN) that allows you to 
omit the attribute names. To search for the distinguished name above you could use:

Goran Lindahl, umdac, Umea Universitet, SE.

The uniqueness requirements leads to long names but there are often shorter forms or 
alternative names in the entry which you can use. Swix will use these when searching for the 
entry. For example the organisation entry "Umea Universitet" also has the following 
organization attributes: "Umea University" and "umu". Because entries that are persons have 
the attribute surname you can even omit the first name:

Lindahl, umdac, umu, se
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Find Examples.

If you want to retrieve a specific entry you enter the name in the text box immediately above 
the List View, and then press the Find button or the Enter key. The search is not case sensitive.
By convention only ascii characters are used in a distinguished name. However national 
characters may be used in alternative values. Suppose you enter the name:

Goran Lindahl, umdac, Umea Universitet, SE

This should give you one entry in the List View and that entry is also displayed in the Entry 
View. The last message in the Message View should be "Added" meaning the search was a 
success and the entry was added to the document.

An alternative way of writing the above entry is to use the distinguished name with the 
attribute names. Normally you don't use that form but for completeness we show it here:

cn=Goran Lindahl, ou=umdac, o=Umea Universitet, c=SE

It is also possible to use shorter forms of names where these exist:

Hedberg, umdac, umu, se

For example "umu" is a shorter name for Umea Universitet and we can also use the fact that 
entries have a surname (last name) attribute. In the Message View you should find that Swix 
found the component "se" but had to search for umu, and then again for Hedberg.

The top level is most often a country but there are some international organisations. The name
of the country is, as you have seen, a two letter country code. There are alternate names if you
don't know the code:

lindahl, umdac, umea university, sweden

For the last two components in the name, which are at the top of the directory tree, we use the 
existing English names.

You can omit components in the name:

lindahl, umu, se

Component omission is sometimes quite all right but there may be many more entries for 
Swix to search through. There are in fact two people with the name Lindahl working at 
"umu". Swix will then display a list box with two entries and you can select one or cancel the 
search.

If there is no match Swix will try an approximate match. This way you may succeed in 
finding an entry although you have misspelled it:

Ulin, umdac, umu, se



Swix 2.2   1995-02-17  8

Will find the entry Stig Uhlin, umdac, Umea Universitet, SE, although "Uhlin" is misspelled.
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You can also use wild cards in the search:

lind*, umdac, umu, se

Since there are several people working at Umdac whose name begins with "lind" Swix will 
display a list box with the entries.

You can in fact replace whole values with wildcards:

*, *, norway

After finding the country all entries will match and Swix will display  the list box. You choose
one entry and then the same thing will happen again at the next level.

Browse Examples.

Consider the entries:

se
umu, se
umdac, umu, se

Neither of the above three entries are leaves. The first is a country, the second is an 
organisation and the third an organisation unit. All of them have entries below them in the 
directory tree which you can list. If you want to browse through all departments in Umea 
university you type the following and click the browse button:

umu,se

Another example of browsing:

matematik,umu,se

If you click the browse button you should see all entries in the department of mathematics.

As a last example of Browse, but the easiest to use, enter no name at all. If the text box is 
blank you will get the top level of the directory. You will then see a lot of country codes, 
DSAs (usually animal names) and some international organisations. If you click on one of the 
entries the name will be copied to the text box and you can continue to browse.
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The UFN Text Box.

In the text box you enter the name which you want to search for.

After a successfull search or when you click on an entry in the List View,  the name of that 
entry will be moved to the text box.

If you want to clear the text box you can press Ctrl+D.

The List View.

In the List View all entries in the document are displayed, one entry on each row. By default 
the Distinguished Name of the entry is displayed but you can display any attribute, by using 
the "Layout/List View Layout" menu.

If you want to change the number of rows that are visible you can drag the bar that separates 
the List and Entry Views.

The current entry is highlighted. To change the current entry click on another row in the List 
View. After the click you can also use the direction keys to select a new entry. You can also 
move by typing a letter, which will move to the next entry starting with that letter. The Home 
and End keys will move to the first and last entry.

By default the Distinguished Name of the entry is displayed but you can specify the layout by 
using the "Layout/List View Layout" menu.

The Entry View.

In the Entry View one entry is displayed. To display another entry in the document click on a 
row in the List View.

If you want to change the size of the Entry View window you can drag either the bar that 
separates it from the List View or the bar that separates it from the Message View. To change 
the default attributes which are displayed use the "Layout / Entry View Layout" menu. 

You can select values in the Entry View by clicking on them. Use Shift+Click to select more 
than one value. The selected text can be copied to the clipboard by the normal Ctrl+C key 
combination.

The Edit View.

When you are modifying or creating a new entry the Entry View will be replaced with the 
Edit View. To be able to do this you have to select the user entry that corresponds to the user 
and use "Directory/Bind As" to authenticate yourself by entering a password.

You can move between the fields with the Tab and Shift+Tab keys or by clicking on the field.
Each edit box contains as many rows as there are values for that entry. To enter new values 
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use the Enter key to open up a new line. If you enter values longer than the edit box the text 
will scroll in the box. Please note that two rows of information are two different values for 
that attribute, except for postal addresses,  and that the ordering of the values can not be 
guaranteed.

Attributes of type PostalAddress have values which contain lines. You enter each line of data 
on a new line in the edit box. If you have to enter more than one  postal address, separate 
them with an empty line.

Attributes of type Password are shown as usual, with the characters replaced by '*'.

To make the changes in the X.500 directory (and in the document) click on the Update button.
To cancel the update use the Cancel button.

The Message View.

In the Message View you will see messages from Swix as a result from operations against the 
server. All items in the directory menu will cause actions against the server. Only messages 
from the last operation are kept. If you want to display more rows in the Message View you 
can drag the bar that separates it from the Entry View.

The last message in the Message View after a successful "find" is one of:

Added: The entry was found and is added to the document.
Replaced: The entry was found. It was already in the document and has now been

updated.

After a successful browse you will see the number of added and replaced entries.

If you are modifying the X.500 directory you will see an error message if the update request 
was not successful.

If you see the message "Waiting for results" Swix is waiting for the server to return the 
results.
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The File Menu.

File / New/ Open / Save / Save As.

You can create a new document, open an existing document and save the document in the 
standard Windows fashion. The default extension for Swix documents is ".swx".

File  / Most Recently Used file list.

This is a handy alternative to the File/Open menu. In the File menu the four most recently 
used documents are displayed.

File / Print / Print Preview.

Swix offers at present some limited printing capabilities. If  you print the List View all entries 
will be printed. You can also print the Entry View but then only that single entry will be 
printed. The Message View is also printable. Please click with the mouse in the appropriate 
View before you select "Print" or "Print preview" from The "File" menu.

File / Write Textfile.

You can write a tab separated textfile. The file is based on the List View and the attribute 
values are separeted by a tab character. This makes the file suitable for a word processor.

You may first want to change the List View layout, for example add telephoneNumber and E-
mail address (mail). If all entries are in the same organisation you may want to remove the 
Distinguished name and instead add the commonName.

File / Exit.

You can exit Swix with this menu alternative or use the Exit button. If you have not saved the 
document  Swix will prompt you.
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The Edit Menu.

Edit / Undo Ctrl+Z.

Undoes changes in the UFN edit box or changes made to an attribute value while updating an 
entry.

Edit / Cut Ctrl+K.

Deletes the selected text and copies it to the clipboard. You can cut from the UFN edit box or 
the attribute field in the Update View.

Edit / Copy Ctrl+C.

Copies selected text to the clipboard from the UFN edit box, from attribute edit boxes while 
updating an entry and from attribute values in the Entry View. To select values in the Entry 
View you click on it. To select more than one value hold down the shift key and click.

Edit / Paste Ctrl+V.

Paste inserts text from the clipboard. You can paste into the UFN edit box and into attribute 
fields while updating an entry.

As an example you can move text between an attribute which contains a distinguished name 
and the UFN edit box to look it up. Click on the attribute value in the Entry View, press 
Ctrl+C, and then click in the UFN edit box. Clear the edit box (Ctrl+D) and then paste with 
Ctrl+V.

Edit / Clear UFN Text Box Ctrl+D.

Use this menu item or press Ctrl+D to empty the text box.

Edit / Delete entry.

This will delete the current entry from the document. You will get a message box to confirm 
the deletion.

Edit / Clear document.

You can delete all entries from the document. A message box will ask you to confirm the 
deletion.
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The Directory Menu.

Directory / Find Ctrl+F.

The menu item "Find entry" and the Find button accomplishes the same thing. Swix will try 
to find the entry matching the name you have entered in the text box.

You can click on an entry in the List View to move the name to the text box.

Directory / Browse Ctrl+B.

The menu item Browse and the Browse button will both try to retrieve all entries below the 
entry you specify in the text box. The first step is actually the same as find, that is to see if the
entry exists. However, in Browse you can have an empty text box. In that case the Browse 
will be performed on the root of the directory tree.

If the results from a browse are organisation entries you might want to continue browsing. To 
do that click on an entry in the List View to bring the name to the search text box and click on
the browse button again.

Directory / Bind As.

You can authenticate yourself by giving a user name and a password. In the user field you can
either type the user or select one from the list box. In the list box you will see all the entries in
the document.

You can save the user name by checking the "Save as default" check box.

If you want to bind unonymous, which is the default,  click the Anonymous button.

If the authentication is successful you will see the message "Bind OK" in the Message View.

Directory / Modify Ctrl+M.

Modifies the entry in the X.500 catalog. Before you can modify the current entry you must 
use the directory/bind menu to enter user and password information. The Entry View will be 
replaced by the Edit View where you can modify the attribute values. Click on the update 
button to make the changes in the X.500 catalog. Use the cancel button to cancel the 
operation.

Directory / Modify RDN.

Modifies the relative distinguished name of the entry. Before you use it you must use the 
directory/bind menu to enter user and password information.

Click on the update button to make the changes in the X.500 catalog. Use the cancel button to 
cancel the operation.
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Directory / New.

Creates a new entry in the X.500 catalog. Before you can modify the current entry you must 
use the directory/bind menu to enter user and password information.

The first step is to select the entry under which the new entry is to be created, assuming it is 
already in the document. When you create a new entry you will get a dialog where you can 
choose what kind of entry to create, for example a new person or organisational unit. The next
dialog will prompt for the relative distinguished name of the new entry and after that the 
Entry View will be replaced with an Edit View where you can enter the new attribute values.

Click on the update button to add the entry to the X.500 catalog. Use the cancel button to 
cancel the operation.

Directory / Repeat New Ctrl+R.

When you have added a new entry with Directory/New you can use this function to create 
more entries of the same type in the same directory. You will save time as you don't have to  
select the directory entry and select an object type again. Otherwise it is the same as 
Directory/New.

Directory / Update Ctrl+U.

When you are modifying an existing or a new entry this menu item will update the X.500 
catalog. The function is the same as clicking on the Update button.

If the update is successful the edit View will be replaced by the Entry View else you will get 
an error message in the Message View. Either correct the error and try again or else click on 
the cancel button to end the editing.

Directory / Delete Ctrl+Del.

You can delete the current entry from the X.500 catalog. You must use the directory/bind 
menu to enter a password. The entry will also be deleted from the document.You will get a 
message box to confirm the deletion.

Directory / Cancel.

While any operation in the Directory menu is going on you can click the cancel button to 
abort the operation.



Swix 2.2   1995-02-17  17

The Layout Menu.

Layout / Sort.

There are four different ways to order the entries:

1. By the distinguished name.
2. By organisations and attribute.

Example: Sort by surname (last name) within the organisations.
3. Sort all entries by attribute:

Example: Sort all entries by telephoneNumber.
4. Sort them in the order that they where retrieved.

In this order you will get the last retrieved entry also last in the List View.

Select the sort order by clicking on an appropriate radio button. Two of the types have an 
attribute associated which you can select from a combo box. Click on the down arrow button 
to open the attribute list.

Layout / List View layout.

In the dialog there are two list boxes. The first one displays all attributes. In the second one 
are the selected attributes or the Distinguished Name in the order in which they will be 
displayed.

By default the distinguished name is displayed in the List View. You can, however, display 
other attributes in the List View. Select the attribute from the left list box and click on the 
right arrow button to move it to the selected attributes list box. The attribute is inserted before 
the selected item in the right list box so you may want to select the position first by clicking in
the right "selected attributes" list box.

If the distinguished name is not selected you can add it with the "Add DN" button.

If the check box labelled "Show attribute names" is checked attribute names will be 
displayed. The format is attributeName= attributeValue.

Layout / Entry View Layout.

In the dialog there are two list boxes. The first one displays all attributes. In the second one 
are the selected attributes in the order in which they will be displayed.

To add an attribute, select it and click the right arrow button. As a shortcut you can double 
click on the attribute.

The attribute is inserted before the selected item in the right list box so you may want to select
the position first by clicking in the right "selected attributes" list box.

To delete an attribute click on the item in the right list box and press the left arrow button or 
double click on the attribute.
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You can insert blank rows by clicking the "Add blank" button. The line is inserted before the 
selected item.

You can add all attributes to the display list with the "Add All" button and you can remove all 
attributes with the "Remove All" button.

The Configure Menu.

Configure / Server.

In the server field you type the Internet address of the server. If you don´t know the name of 
any you can always try x500.sunet.se.

Port is a field which you normally can set to zero, Swix will then use the default LDAP port.

If the keep connection check box is checked the connection to the server will be up from the 
first operation until you end Swix ( or do a new "Bind as" or change of server). If unchecked 
Swix will disconnect after each operation.

Configure / Search.

The initial UFN list box.

You can change or remove the initial UFN . To remove it choose the NONE alternative in the 
list box. You can set it to the name of any entry in the document all of which will be present in
the list box.

Size and time limits.

Size limit sets a limit on how many entries are returned from the server.

Time limit sets a limit on how long the server should spend trying to answer your search 
request.

The approximate match check box.

Swix will try an approximate match if no exact match is found. The matching is done by the 
DSA and the result is sometimes strange. If there are too many matches it is not so harmful 
but sometimes a little spelling mistake may produce no match at all.

To disable approximate matching uncheck the check box.

Configure / Launch application.

You can associate an attribute with an external application so that when you double-click on 
the attribute value in the Entry View the applicaton will start. You can even specify 
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parameters to the application. This is useful when you wish to pass the attribute value.

To set up the connection between an attribute and an application you first display an entry that
contains the attribute and then click on the value in the Entry View. 

In the dialog you will see the Label and the name of the attribute (in parentheses) on the first 
line.

In the Application edit box you fill in the path and name of the application. You can use the 
Browse button to get the path and name.

In the Parameter edit box you can enter parameters to the application. The percent character 
has a special meaning: The entire value of the attribute will be inserted in the parameter 
string. Example:

Attribute: E-mail (mail)
Application: c:\xxx\yymail.exe
Parameter: %

A double-click on any mail attribute will start c:\xxx\yymail with the attribute value as a 
parameter.

Any other text in the parameters field will be passed unchanged, for example:

Parameter -r % -d john

will be passed as "-r " followed by the attribute value followed by " -d john”.

You can also refer to different parts of the attribute value which are separated by blanks. To 
do this you specify a parameter number (1-9) directly after the "%". For the first part use 
"%1", for the second part use "%2", etc.

As an example the attribute labeledURL contains an url and a label which can look like:
”http://macavity.umdc.umu.se/~roland/myself.html My homepage”. (A space separates ”html”
from ”My”)

Attribute: URL (labeledURL)
Application c:\netscape\netscape.exe
Parameter %1

The first part which contains the url is passed to netscape.

If no value from the attribute value is specified in the parameter field, that is it does not 
contains any ”%”, the attribute value will be copied to the clip board. When the application 
has started you can easily paste the attribute value.

The Help Menu.
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The help system is based on this document. You can click on a help topic or search using 
keywords.


